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1. Установка. 
 

Перед установкой адаптера на компьютере пользователя уже должен быть установлен MultiCharts 
и терминал “Рабочее место Quik”. 

В случае, если у Вас уже есть установленный адаптер Quik, перед установкой новой версии 
желательно деинсталлировать предыдущую. 

Перед установкой адаптера закройте терминал Quik и все приложения MultiСharts (QuoteManager, 
PLEditor …). 

Во время установки адаптера электронный ключ Dongle должен быть подключен к компьютеру.  

Во время установки адаптера Вам будет предложено выбрать папку для установки. 

 

В поле ввода «Папка» необходимо выбрать папку с установленным MultiCharts. 

 

2. Установка новой версии адаптера при наличии старой. 
Перед установкой новой версии адаптера деинсталлируйте старую. 
 

3. Удаление и отказ от использования адаптера. 
После деинсталляции адаптера восстановите MultiСharts через «Установку/Удаление» 
программ панели управления Windows. 
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4. Настройка терминала Quik 
 

Запустите терминал Quik. 

Зайдите в меню «Связь->Списки» 

 

Выберите вкладку «Получение данных» 

 

Нажмите на кнопку «Снять фильтры» и убедитесь, что сняты для всех классов инструментов 
галочки «Фильтр инструментов» и «Фильтр параметров». 

Нажмите на кнопку «Выделить все». 

Примечание: «Если Вам не нужно получать все инструменты, то настройте фильтр инструментов по своему усмотрению. Галка «Фильтр 
параметров» должна быть снята.» 

Нажмите кнопку «Да». 
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Зайдите в меню «Настройки -> Основные» 

 

Выберите вкладку «Получение данных» 
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Здесь необходимо для корректного экспорта таблицы «текущих параметров» в разделе 
«Сохранять для получаемых инструментов и параметров:» 

- Выбрать пункт «Данные, отражающие текущее состояние и всю историю изменений». 

- Поставить флажок «Получать пропущенные данные». 

И нажать кнопку «Сохранить». 
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Далее открыть меню «Торговля -> Внешние транзакции» 

 

 

В появившемся диалоге: 

 

Нужно поставить флажок «Запускать процесс обработки внешних транзакций автоматически» и 
нажать кнопку «Начать обработку». 
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5. Настройка экспорта таблиц по протоколу ODBC 
Для удобства рекомендуется создать закладку «ODBC» в терминале Quik, для этого выберите 
пункт меню «Окна > Сделать закладки». 

 

В появившемся диалоге: 

 

Нажмите на кнопку «Добавить» и в появившемся диалоге напишите название закладки, например 
– «ODBC». 

Для настройки экспорта по ODBC необходимо в созданной закладке создать таблицы в терминале 
Quik: 
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- Клиентский портфель. 

- Таблица лимитов по бумагам. 

- Текущая таблица параметров. 

- Таблица всех сделок 

- Таблица заявок 

- Таблица сделок 

- Таблица стоп-заявок 

- Ограничения по клиентским счетам (фьючерсы) 

- Позиции по клиентским счетам (фьючерсы). 

И настройте экспорт инструментов по ODBC(DOM- стаканы заявок) 

 

Клиентский портфель. 
Для добавления таблицы «Клиентский портфель» выберите пункт меню «Лимиты->Клиентский 
портфель» 

 

В появившемся диалоге добавьте колонки  
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- Фирма 

- Код клиента 

- ТекСредства 

- Сумма ден. остатков 

И нажмите на кнопку «Да». 

Галки Маржиальные и Немаржиальные клиенты должны стоять. 

Все фильтры должны быть сняты. 

Далее кликом правой кнопкой мыши в таблице «Клиентский портфель» в контекстном меню 
выберите пункт «Вывод по ODBC»: 
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В появившемся диалоге: 

 

В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - 
«….\QuikData.Портфель». 

Обязательно поставьте флажок «Чистить таблицу перед выводом», а так же «Вывод при нажатии 
Ctrl+Shift+O».  

«Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы 
Фирма Фирма 
Код клиента Код_Клиента 
ТекСредства Тек_Средства 
Сумма ден. остатков Сумма_Ден_Остат 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 
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Таблица лимитов по бумагам. 
Для добавления таблицы «Таблица лимитов по бумагам» выберите пункт меню «Лимиты-
>Лимиты по бумагам» 

 

В появившемся диалоге добавьте колонки  

 

- Название бумаги 

- Счет депо 

- Код бумаги 

- Код клиента 

- Текущий остаток 

- Цена приобретения 
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- Фирма 

Поставьте флажок «Показывать нулевые лимиты». 

Все фильтры должны быть сняты. 

И нажмите на кнопку «Да». 

Далее кликом правой кнопкой мыши в таблице «Таблица лимитов по бумагам» в контекстном 
меню выберите пункт «Вывод по ODBC»: 

 

 

В появившемся диалоге: 

 

В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - 
«….\QuikData.ЛимитыПоБумагам». 
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Обязательно поставьте флажок «Чистить таблицу перед выводом», а так же «Вывод при нажатии 
Ctrl+Shift+O».  

«Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

 

Список параметров Список полей таблицы 
Название бумаги Бумага 
Код бумаги Код_Бумаги 
Счет депо Счет_Депо 
Код клиента Код_Клиента 
Текущий остаток Текущий_Остаток 
Цена приобретения Цена_Приобретения 
Фирма Фирма 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 
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Текущая таблица параметров. 
Для добавления таблицы «Текущая таблица параметров» выберите пункт меню 
«Таблицы > Текущая Таблица» 

 

В появившемся диалоге поставьте флажки: 

- «Вывод по ODBC только изменившихся полей» 

- «Короткие названия параметров» 

Нажмите на кнопку «Добавить все» 

Или выберите только используемые бумаги. 
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Добавьте колонки: 

- Бумага 

- Бумага сокр. 

- Код бумаги 

- Код класса 

- Цена послед. 

- Предл. 

- Спрос 

- Кол-во послед. 

- Оборот посл. 

- Кол. предл. 

- Кол. спрос 

- Время послед. 

- Точность 

- Лот 

- Шаг цены 

- Баз. актив 

- Дата исп. 

- Тип опциона 

- Страйк 

- Дата торгов 

- Лучш. пред. 

- Лучш. спрос 

- Откр. 

- Макс. цена 

- Мин. цена 

- Оборот 

-Общ. кол-во 

- Время изм. 

- Макс. возм. цена 

- Мин. возм. цена 

- Кол-во отк. поз. 

- Цена закр. 

- Измен. к закр. 

- % измен. закр. 

И нажмите на кнопку «Да». 

Стр. 16 из 50 

 



Далее кликом правой кнопкой мыши в таблице «Текущая таблица параметров» в контекстном 
меню выберите пункт «Вывод по ODBC»: 

 

В появившемся диалоге: 

 

В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - 
«….\QuikData.Текущая». 

Обязательно поставьте флажок «Чистить таблицу перед выводом», а так же «Вывод при нажатии 
Ctrl+Shift+O».  

«Вывод после создания» поставьте по желанию. 
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Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы Примечание 
Инструмент Инструмент 

Обязательное поле 

Бумага Бумага 
Бумага сокр. Бумага_Сокр 
Код бумаги Код_Бумаги 
Код класса Код_Класса 
Цена послед. Цена_послед 
Предл. Предл 
Спрос Спрос 
Кол-во послед. Кол_во_Послед 
Оборот посл. Оборот_посл 
Кол. предл. Кол_Предл Нужно для графиков bid/ask Кол. Спрос Кол_Спрос 
Время послед. Время_послед 

Обязательное поле Точность Точность 
Лот Лот 
Шаг цены Шаг_цены 
Баз. актив Баз_Актив Обязательно для фьючерсов Дата исп. Дата_исп 
Тип опциона Тип_опциона Обязательно для опционов Страйк Страйк 
Дата торгов Дата_Торгов Обязательное поле 
Лучш. пред. Лучш_пред Пока никак не используются Лучш. спрос Лучш_спрос 
Откр. Откр 

Нужно для статус-строки в MC 
Макс. цена Макс_цена 
Мин. цена Мин_цена 
Оборот Оборот 
Общ. кол-во Общее_кол_во 
Время изм. Время_изм 

Обязательно для фьючерсов Макс. возм. цена Макс_возм_цена 
Мин. возм. цена Мин_возм_цена 
Кол-во отк. поз. Кол_Откр_позиций Пока никак не используются 
Цена закр. Цена_закр Нужно для статус-стоки в MC 
Измен. к закр. Изм_закр Пока никак не используются 
% измен. закр. Изм_закр_пцнт Пока никак не используются 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 
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Таблица всех сделок. 
Для добавления таблицы «Таблица всех сделок» выберите пункт меню «Таблицы->Таблица всех 
сделок» 

 

В появившемся диалоге нажмите кнопку «Выделить все», после для каждого класса снимите 
флажок «Фильтр ценных бумаг» 

 

 

Добавьте колонки: 

- Номер 

- Дата 

- Время 

- Код бумаги 

- Код класса 
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- Цена 

- Кол-во 

- Объем 

- Операция 

И нажмите на кнопку «Да». 

Далее кликом правой кнопкой мыши в таблице «Таблица всех сделок» в контекстном меню 
выберите пункт «Вывод по ODBC»: 

 

В появившемся диалоге: 

 

В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - 
«….\QuikData.Все_Сделки». 
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Обязательно поставьте флажок «Чистить таблицу перед выводом», а так же «Вывод при нажатии 
Ctrl+Shift+O».  

«Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы 
Номер Номер 
Дата Дата 
Время Время 
Код бумаги Код_бумаги 
Код класса Код_Класса 
Цена Цена 
Кол-во Количество 
Объем Объем 
Операция Операция 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 
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Таблица заявок. 
Для добавления таблицы «Таблица заявок» выберите пункт меню «Торговля->Заявки» 

 

В появившемся диалоге нажмите кнопку «Выделить все»,  

 

 

После, для каждого класса, снимите флажки: 

«Фильтр ценных бумаг» 

«Фильтр фирм» 

«Фильтр счетов депо» 
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«Фильтр клиентов» 

Установите флажки в категории «Фильтр состояния»: 

«Активные» 

«Исполненные» 

«Снятые» 

Снимите флажек «Только частично исполненные» 

Установите флажки в категории «Фильтр операции» 

«Покупка» 

«Продажа» 

Добавьте колонки: 

- Номер 

- Дата 

- Выставлена (время) 

- Код клиента 

- Счет 

- Код бумаги 

- Код класса 

- Операция 

- Цена 

- Кол-во 

- Остаток 

- Объем 

- Состояние 

- Тип 

И нажмите на кнопку «Да». 

Далее кликом правой кнопкой мыши в таблице «Таблица всех сделок» в контекстном меню 
выберите пункт «Вывод по ODBC»: 
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В появившемся диалоге: 

 

В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - 
«….\QuikData.Заявки». 

Обязательно поставьте флажок «Чистить таблицу перед выводом» и «ФОРМАЛЬНЫЕ ИМЕНА», а 
так же «Вывод при нажатии Ctrl+Shift+O».  

 «Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы 
Номер Номер 
Дата Дата 
Выставлена (время) Выставлена_Время 
Код клиента Код_Клиента 
Счет Счет 
Код бумаги Код_бумаги 
Код класса Код_Класса 
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Операция Операция 
Цена Цена 
Кол-во Кол_во 
Остаток Остаток 
Объем Объем 
Состояние Состояние 
Тип Тип 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 

 

Таблица сделок. 
Для добавления таблицы «Таблица сделок» выберите пункт меню «Торговля->Сделки» 

 

В появившемся диалоге нажмите кнопку «Выделить все», после для каждого класса снимите 
флажок «Фильтр ценных бумаг» 
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Снимите флажки с фильтров: 

«Фильтр ценных бумаг»  

«Фильтр фирм» 

«Фильтр счетов депо» 

«Фильтр клиентов» 

Поставьте флажки в категории «Фильтр операций»: 

«Покупка» 

«Продажа» 

 

Поставьте флажки в категории «Фильтр типа сделок» 

«Немаржианальная» 

«Маржинальная» 

Добавьте колонки: 

- Номер 

- Дата торгов 

- Время 

- Заявка 

- Код бумаги 

- Код класса 

- Операция 

- Счет 

- Цена 

- Кол-во 

- Объем 

- Код клиента 

И нажмите на кнопку «Да». 

Далее кликом правой кнопкой мыши в таблице «Таблица всех сделок» в контекстном меню 
выберите пункт «Вывод по ODBC»: 
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В появившемся диалоге: 

 

В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - «….\QuikData. 
Сделки». 

Обязательно поставьте флажок «Чистить таблицу перед выводом» и «ФОРМАЛЬНЫЕ ИМЕНА», а 
так же «Вывод при нажатии Ctrl+Shift+O».  

 «Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы 
Номер Номер 
Дата торгов Дата_Торгов 
Время Время 
Заявка Заявка 
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Код бумаги Код_Бумаги 
Код класса Код_Класса 
Операция Операция 
Цена Цена 
Счет Счет 
Кол-во Кол_во 
Объем Объем 
Код клиента Код_Клиента 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 

 

Таблица стоп-заявок. 
Для добавления таблицы «Стоп-заявки» выберите пункт меню «Торговля->Стоп-заявки» 

 

В появившемся диалоге нажмите кнопку «Выделить все», после для каждого класса снимите 
флажки: 
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 «Фильтр ценных бумаг» 

«Фильтр фирм» 

«Фильтр счетов депо» 

«Фильтр клиентов» 

Выберите все фильтры состояния: 

«Активные» 

«Исполненные» 

«Снятые» 

Выберите все фильтры операций: 

«Покупка» 

«Продажа» 

Добавьте колонки: 

- Номер 

- Дата 

- Время 
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- Код клиента 

- Счет 

- Код бумаги 

- Код класса 

- Операция 

- Стоп-цена 

- Цена 

- Кол-во 

- Акт. Кол-во 

- Исп. Кол-во 

- Номер заявки 

- Состояние 

- Результат  

И нажмите на кнопку «Да». 

Далее кликом правой кнопкой мыши в таблице «Таблица всех сделок» в контекстном меню 
выберите пункт «Вывод по ODBC»: 

 

В появившемся диалоге: 
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В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - 
«….\QuikData.Стоп_заявки». 

Обязательно поставьте флажок «Чистить таблицу перед выводом» и «ФОРМАЛЬНЫЕ ИМЕНА», а 
так же «Вывод при нажатии Ctrl+Shift+O».  

«Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы 
Номер Номер 
Дата Дата 
Время Время 
Код клиента Код_Клиента 
Счет Счет 
Код бумаги Код_бумаги 
Код класса Код_Класса 
Операция Операция 
Стоп-цена Стоп-Цена 
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Цена Цена 
Кол-во Количество 
Акт. Кол-во Активно 
Исп. Кол-во Исполнено 
Номер заявки Номер_заявки 
Состояние Состояние 
Результат Результат 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 

Ограничения по клиентским счетам (фьючерсы) 
Для добавления таблицы «ограничения по клиентским счетам» выберите пункт меню «Торговля-
>Фьючерсы->Ограничения по клиентским счетам» 

 

В появившемся диалоге:  
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Снимите флажки: 

 «Фильтр фирм» 

«Фильтр счетов» 

И поставьте флажек Показывать лимиты по «ден. средствам». 

Добавьте колонки: 

- Фирма 

- Торговый счет 

- Тип лимита 

- Тек. чист. поз. 

- План. чист. поз. 

И нажмите на кнопку «Да». 

Далее кликом правой кнопкой мыши в таблице «Таблица всех сделок» в контекстном меню 
выберите пункт «Вывод по ODBC»: 
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В появившемся диалоге: 

 

В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - 
«….\QuikData.ОграниченияПоСчетам». 

Обязательно поставьте флажок «Чистить таблицу перед выводом» а так же «Вывод при 
нажатии Ctrl+Shift+O».  

«Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы 
Фирма Фирма 
Торговый счет Торг_счет 
Тип лимита Тип_лимита 
Тек. чист. поз. Тек_чист_ поз 
План. чист. поз. План_чист_поз 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 
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Позиции по клиентским счетам (фьючерсы) 
Для добавления таблицы «ограничения по клиентским счетам» выберите пункт меню «Торговля-
>Фьючерсы->Позиции по клиентским счетам» 

 

В появившемся диалоге:  

 

Снимите флажки: 

 «Фильтр фирм» 

«Фильтр бумаг» 

«Фильтр счетов» 
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И поставьте флажок Показывать лимиты по «ден. средствам». 

Добавьте колонки: 

- Фирма 

- Торговый счет 

- Код инструмента 

- Тек. чист. поз. 

- Краткое название 

- Тип (если есть в списке полей) 

И нажмите на кнопку «Да». 

Далее кликом правой кнопкой мыши в таблице «Таблица всех сделок» в контекстном меню 
выберите пункт «Вывод по ODBC»: 

 

В появившемся диалоге: 
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В качестве источника данных выберите «QuikData», а в «Список доступных таблиц» - 
«….\QuikData.ПозицииПоФьючерсам». 

Обязательно поставьте флажок «Чистить таблицу перед выводом» а так же «Вывод при 
нажатии Ctrl+Shift+O».  

«Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы 
Фирма Фирма 
Торговый счет Торг_счет 
Код инструмента Код_инстр 
Тек. чист. поз. Тек_чист_ поз 
Краткое название Крат_назв 
Тип (если есть в терминале) Тип 
 

Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 

Стр. 37 из 50 

 



 

Экспорт инструментов по ODBC (DOM- стаканы заявок) 
Для того, чтобы в MultiCharts могли отображаться и работать стаканы заявок по инструментам. 
Необходимо настроить экспорт инструментов по ODBC. 

 

В появившемся диалоге:  

 

Выберите инструменты, по которым хотите получать стакан (все выбирать не нужно, т.к. это 
замедлит работу адаптера и к тому эе термина сам не может выводить стаканы больше, чем по 
200 инструментам). 

Затем нажмите кнопку «Настроить». 

В появившемся диалоге: 
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Выберите источник  QuikData. Нажмите «Присоединиться» и выберите таблицу «QuikData.DOM». 

Обязательно поставьте флажок «Чистить таблицу перед выводом» и «ФОРМАЛЬНЫЕ ИМЕНА», а 
так же «Вывод при нажатии Ctrl+Shift+O».  

 «Вывод после создания» поставьте по желанию. 

Настройте соответствие Список параметров – Список полей таблицы: 

Список параметров Список полей таблицы 
Инструмент Инструмент 
Цена Цена 
Покупка Покупка 
Продажа Продажа 
Нажмите кнопку «Начать вывод данных» и затем кнопку «Да». 

Нажмите «Запустить», а затем «Да» в диалоге «Настройка экспорта инструментов по ODBC». 
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Если потом потребуются стаканы по другим инструментам, достаточно будет выбрать новые 
инструменты в диалоге «Настройка экспорта инструментов по ODBC». 

 

6. Подготовка терминала перед запуском MultiCharts 
Перед запуском MultiCharts необходимо запустить терминал Quik и запустить в нем экспорт 
таблиц по ODBC, для этого необходимо в меню выбрать пункт «Экспорт данных -> Начать экспорт 
таблиц по ODBC». 

 

Терминал начнет экспорт таблиц в базу данных.  

Желательно, но не обязательно, перед началом работы с MultiCharts дождаться пока Quik не 
выгрузит все данные в  базу данных. В начале сессии это 1-2 минуты под конец сессии это может 
занять до нескольких десятков минут.  

Если не дождаться пока все данные будут выгружены в базу данных, то может быть доступен не 
полный список инструментов для торговли, а так же могут не приходить тики в реальном времени, 
до тех пор, пока не закончится экспорт истории таблиц в базу данных.  

Образовавшуюся дыру в данных на графике можно будет залатать путем нажатия комбинации 
клавиш в MultiCharts «Ctrl + R». 

 

7. Настройка поставщика «Quik» в QuoteManager  
Запустите QuoteManager. 

 

Выберите пункт меню «Tools > Data Sources…» 

 

В появившемся диалоге: 
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Выберите Data Source «Quik» и нажмите кнопку «Settings…». 

В появившемся диалоге: 

 

Выберите откуда брать объем  для тиков: 

Объем в контрактах – количество сделок в тике. 

Объем в деньгах – объем тика. 

 

Выберите, что использовать в качестве объема, и откуда брать реалтайм. 
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Историю адаптер предоставляет только за текущую сессию и берет всегда, не зависимо от 
режима, из таблицы «всех сделок». 

Реалтайм поставляется согласно выбранного режима или из таблицы «всех сделок» или из 
таблицы «текущих параметров». 

Если реалтайм берется из таблицы всех сделок, то данные в МС будут приходит без разрывов, 
даже если Quik терял соединение с сервером на продолжительное время. В момент 
восстановления связи Quik догрузит пропущенные тики в таблицу «всех сделок» и они по мере 
догрузки попадут в МС. (для автоматической торговли может быть не приемлемо, т.к. МС все 
догружаемые тики после разрыва связи будет считать реалтаймом).  

Еще недостатком режима является отставание графиков от текущего времени в период активного 
движения рынка, т.к. в Quik эта таблица является менее приоритетной и данные приходят в нее 
пачками и с задержкой по сравнению с таблицей текущих параметров. Соответственно возрастает 
нагрузка на процесс построения баров из тиков (приходится обрабатывать тики пачками).  

Если реалтайм берется из таблицы текущих параметров, то тики будут приходить в МС по одному 
(скорость выше), но не гарантируется поступление всех тиков. В случае разрыва связи, 
образовавшаяся дыра на графике не затягивается, т.к. в эту таблицу поступает актуальная 
информация.  

Настройки стаканов заявок: 

Ограничить глубину стакана – в МС будет отправляться не больше указанного количество строка с 
покупками и продажами. Эта опция позволит ускорить работу МС со стаканами. 

Выводить стакан не чаще, чем раз в X миллисекунд. -  Сткан будет отсылаться в МС не чаще 
указанного, что так же позволит снизить потребление ресурсов МС, особенно актуально для очень 
активных стаканов.  

Ограничения на стакан влияют только на отображение информации в МС, и ни как ни 
сказываются на отсылке и исполнении ордеров и стакане. 

 

8. Настройка биржи в QuoteManager 
Выберите пункт меню «Tools->Exchanges & ECNs…». 

 

 

В появившемся диалоге: 
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Нажмине кнопку «Add…» и на вкладке «General» диалога “Edit Exchange & ECN” заполните поля: 

Exchange & ECN: «Московская Межбанковская Фондовая биржа» (или любое другое) 

Abbr: «MICEX» - обязательно 

Holiday List: Russia – не обязательно 

PriceScale: 1/10 000 – не обязательно. 

Sessions: C понедельника по пятницу с 10:30 до 18:45 в конце каждого дня галочка Session End. 

На вкладке «TimeZone» 
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Выберите опцию «Custom» . 

«Offset from GMT when not under daylight saving» установите в «-240» минут. 

Нажмите «OK» и закройке все диалоги. 

 

Аналогично добавьте биржу «RTS». 
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9. Добавление символов от «Quik» в MultiCharts 
 

Запустите MultiCharts. 

Выберите пункт меню «File -> New -> Chart Window» 

 

В появившемся диалоге  

 

Выберите Data Source «Quik» Далее нажмите кнопку «Add… -> Add Symbol…» 

Стр. 45 из 50 

 



 

В появившемся диалоге выберите желаемые инструменты: 
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И нажмите кнопку «OK». 

Далее можно строить чарты по добавленным символам из «Quik». 
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10. Настройка профиля «Quik» для автоматической торговли 
Выберите пункт меню «File -> Broker Profiles ->  Manage Broker Profiles…» 

 

В появившемся диалоге: 

 

Нажмите кнопку «New->Quik». 

Далее выберите «Quik» и нажмите кнопку «Edit…»: 

В появившемся диалоге: 
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Заполните поля: 

«Путь к терминалу Quik» - место расположения файла info.exe 

«Номер счета Депо» – номер счета депо  (можно подсмотреть в терминале Quik в диалоге ввода 
заявки) 

«Код клиента» – номер Вашего брокерского счета(он же - код клиента) (можно подсмотреть в 
терминале Quik в диалоге ввода заявки) 

 

Нажимайте «OK», закрывайте диалоги.  
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Эмуляция рыночных-ордеров: 

«Отсылать как лимитированную заявку» 

 Отступ лимитированной цены (от текущего bid – для продажи и ask – для покупки) можно 
задавать в процентах или пунктах (пункт – шаг цены по инструменту). 

«Отсылать как рыночную заявку» - будет послана рыночная заявка в терминал. 

Эмуляция стоп-ордеров: 

«Отсылать, как стоп-лимит ордера» 

Отступ лимитированной цены (от стоп-цены ордера) можно задавать в процентах или 
пунктах (пункт – шаг цены по инструменту). 

 «Отсылать как рыночный ордер по достижению стоп-условия» - адаптер сам отслеживает  
текущий ask( для покупки )и bid( для продажи).  

Как только цена достигает или пробивает стоп – уровень, генерируется рыночная или 
лимитированная заявка в зависимости от настроек «Эмуляции рыночных ордеров», которая 
отправляется в терминал. 

 

Теперь все настроено, и можно приступать к работе. 
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